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NOTE: Screen shots that appear throughout this document come from a variety of I-Share 
databases. The settings do not always represent the values your library should be using for 

your policies.  

 

Page references refer to the Voyager 9.1.1 System Administration User’s Guide.  
http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/V_System_Admin_9_1_1.pdf  
 

II. Introduction 
This chapter of the I-Share System Administration document is a concise and annotated supplement to 

the Security portion of the full Voyager 9.1.1 System Administration User’s Guide. Use this document to 

learn the I-Share consortial requirements and recommendations for the settings in the Security portion of 
Voyager System Administration to guide your profiling and configuring in Voyager.  

 
The Voyager 9.1.1 System Administration User’s Guide contains additional information and 

explanations; consult Chapter 9, page 9-1 through page 9-125 for further detail.  

http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/V_System_Admin_9_1_1.pdf  
 

The sections in this chapter are arranged in the order that they should be edited when a library is first 
implementing Voyager as an I-Share participant. Some parts of Security SysAdmin build upon each other, 

so doing the initial data entry work in the order outlined in this document should make this process more 
efficient for library staff. 
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III. Security Overview 
The different sections of Security are listed below in the order they appear on the screen when 

SysAdmin> Security is opened. Each section will be described in subsequent sections of this chapter in 
the order they should be edited by a library first implementing Voyager. 

 

 

Acq/Serials Profiles This section determines to whom you give various 

Acquisitions/Serials privileges and for which location(s). 

 

Cataloging Profiles This section determines to whom you give various Cataloging 

privileges and for which location(s). 

 

Circulation Profiles This section determines to whom you give various Circulation 

privileges and for which location(s). 

 

Master Profiles This section determines to whom you give various System 

Administration editing privileges. 

 

Operator Profiles In this section you establish Individuals’ names or Generic 
Account names, e.g., Melvil Dewey, Circ Clerk, circstudent. 

 

Global Data 
Change Profiles 

Not in use. This section determines to whom you give various 
Global Data Change privileges. 

 

Security Options This section allows you to implement password requirements 

for operators at your library. 

 

New I-Share libraries should start by editing the Security Options in SysAdmin> Security, then next 

creating the Operator Profiles. Once the Operators are defined, the next step is to create the different 
Profiles in each functional area (e.g., Cataloging Profiles, Circulation Profiles, and Acquisitions Profiles) 

that determine the level of privileges within each Voyager client.  
 

An individual Operator can be included in only one profile within each of the four functional areas.  
• For example, Melvil Dewey’s Operator ID cannot be linked to both a “Copy Cataloging” and 

“Cataloging Supervisor” Cataloging Profile.  

• However, Melvil Dewey’s Operator ID can be linked to both a “Cataloging Supervisor” Cataloging 

Profile and “Circulation Supervisor” Circulation Profile.  

It is possible to have staff with profiles in the Master, Acq/Serials, Cataloging, and/or Circulation 
categories. Any combination of these types is possible for one Operator.  

 
Review pages 9-4 through 9-9 of the Voyager 9.1.1 System Administration User’s Guide for 
more information about the common elements found in all Security Profiles. 
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The information about creating Master Profiles is found at the end of this chapter because it is different 

from the rest of SysAdmin Security. Master Profiles determine the permissions for the System 
Administration module itself. Master Profiles are very powerful and should be carefully assigned.  

IV. Security Options 
The Security Options section allows you to implement password requirements for operators at your 
library. A few password minimum requirements are set; these requirements apply to any NEW or 

CHANGED password. 

A. Password Requirements Tab 

 
Security- Security Options- Password Requirements Tab 

 

Review pages 9-118 through 9-123 of the Voyager 9.1.1 System Administration User’s Guide 
for more information about the Security Options> Password Requirements Tab. 

 

Libraries can determine which password requirements they want to require for their library staff 
member’s operator passwords. 

 
The options are granular in terms of number of alphanumeric, specific case, and special characters; 

password length; password age; and the ability to contain the operator’s name or username.  
 

The only required setting is password length.  
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B. Password Requirements 2 Tab 

 
Security- Security Options- Password Requirements 2 Tab 

 

Review pages 9-123 through 9-124 of the Voyager 9.1.1 System Administration User’s Guide 
for more information about the Security Options> Password Requirements 2 Tab. 

 
Library staff members can change their passwords from within the File Menu of each Voyager client. 

• This option does not allow staff members who have forgotten their password to reset it; rather, 

it allows a staff member who is unsatisfied with their known password to update it, or whose 

password is set to expire to change it before it does expire. 
Most I-Share libraries have a balance of generic and user-specific usernames and passwords (operators). 

• Voyager does not discriminate between which usernames can have the passwords changed in 

the clients. It would be possible for a single library staff member to change the password for one 
of the generic accounts, for example, “Circstudent”. 

• Should this happen, a Voyager System Administrator with Master Profile- Security (add, edit, 

delete) privileges retains the ability to update the password from within the SysAdmin client. 
 

On this tab: 

• Enter the text shown on the password change screen in the Voyager clients. You can edit the 

warning to be appropriate for your library; the same warning shows in all Voyager clients. 
• Choose whether an operator will be blocked (and for how long) following incorrect/invalid login 

attempts. Zero (0) invalid login attempts means that the username will not be blocked. 
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C. Invalid Login Attempts Tab 

 
Security- Security Options- Blank Logs, Invalid Login Attempts Tab 

 

Review pages 9-124 through 9-125 of the Voyager 9.1.1 System Administration User’s Guide 
for more information about the Security Options> Invalid Login Attempts Tab. 

 
The Invalid Login Attempts Tab records invalid login attempts (incorrect username or password). 

 

The “Record invalid login attempts”  checkbox is checked by default. Uncheck the checkbox if you do not 
wish to log this information. 
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Security- Security Options- Example logs, Invalid Login Attempts Tab 

 

A few comments about the logs: 
• The logs can be useful when library staff report login issues.  

o If the Operator Name column is blank, it means the entered UserID did not match an 

existing Operator, so the entered username was incorrect. 
o If the Operator Name column contains a name, it could either mean that the library staff 

member entered the incorrect password, or their account was already locked from 
previous login errors. Check the Lockout Counter column for the latter. 

• The data from the log can be exported to Excel for local evaluation, if desired. 

• You can clear the log as desired using the “Clear” button. 

• You may occasionally see CARLI Staff usernames in the list ☺ 
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V. Operator Profiles  
Libraries performing their initial SysAdmin work for Security should next create Operator Profiles (i.e., 
accounts, or aka usernames/passwords) for all appropriate staff in the library.  
 

⊕⊕⊕⊕ Libraries should create as many Operator accounts as needed to support local operations. 

 

 
Security- Operator Profile Workspace 

 

When you click the Operator Profiles icon, the display includes both the full name and the login ID 

(username) for the accounts created previously. 
 

Review pages 9-15 through 9-23 of the Voyager 9.1.1 System Administration User’s Guide for more 
information about Operator Profiles. 
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Overview 
Your library can create a unique operator for each individual staff member, or you can create generic 
operators used by multiple staff members. You can also combine both approaches.  

• ���� Balance the security needs and the transaction history functions in Voyager with the effort 

required to maintain the operator accounts.  

• ���� CARLI recommends that functional area profiles with higher levels of privileges be linked to 

individual operator accounts rather than generic accounts. 

 
Information about Specific Operators in Voyager 

∅∅∅∅ When Ex Libris (ExL) creates a new Voyager database, Ex Libris staff add a default operator of 

“SYSADMIN”.  

• This operator is intended for use by ExL staff only; most of its values cannot be edited.  

• CARLI staff will change the default password associated with the SYSADMIN operator upon the 

library’s formal acceptance of their production bib load.  

• ∅∅∅∅ Do NOT change the password for the SYSADMIN operator locally. 

⊕⊕⊕⊕ When Ex Libris (ExL) creates a new Voyager database, they usually add two operators for the data 

review process: “test” and “demo.”  

• ⊕⊕⊕⊕ You should delete these two operators once the library in live in production for all modules.  

• ExL uses the same Operator ID and password for these accounts for all Voyager customers, and 

as a result, these Operators are inherently insecure and should be deleted.  

∅∅∅∅ CARLI staff will create operators in each I-Share library’s database to be used by CARLI staff only, for 

troubleshooting purposes.  

• ∅∅∅∅ Do NOT edit any operators with a last name of “CARLI” (or “ILCSO” in older I-Share 

databases), including editing or deleting any profiles to which these operators are linked. 
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Adding/Editing an Operator  

 
Security- Operator Profiles- New Profile, Operator Tab 

 
In Voyager SysAdmin> Security> Operator Profiles 

• To Add a new operator, click [New]. 

• To Edit an existing operator’s record, highlight the name and click [Edit]. 

• To Delete an operator, highlight the name and click [Delete]. 

 
Adding a New Operator:  

1. On the Operator tab, enter the operator information: 

• Each of these may include alphanumeric characters, punctuation, and spaces.  

• Alphabetic characters are case-sensitive (e.g., mdewey is different from MDewey). 

• First Name (25 characters maximum) 

• Middle Initial, if desired (1 character maximum) 

• Last Name (25 characters maximum) 

• ID (10 characters maximum; this is the username that the operator enters when 

logging into Voyager) 
• Password (minimum of 8 characters, maximum of 25 characters); other criteria 

may apply as set in the SysAdmin> Security> Security Options section. 

• Decide whether the checkboxes for Expire password immediately orThis password never 
expires should be checked. 
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o Expire password immediately forces the staff member to change their password 

upon their next login to a Voyager client. 
o This password never expires prevents an operator’s password from expiring 

even if the criteria for expiration set in the Security Options have been met (see 
page 4 of this document). 

• When finished entering a new Operator, click [Save].  

 

Passwords: 
• can be changed by the operator in any Voyager client. The File menu in each client has a 

“Change Password” option. 

• should be changed regularly by your library’s Sys Admin person for generic accounts. 

• is masked and cannot be viewed within SysAdmin. 

Reviewing an Operator’s Voyager Permissions 
After this Operator is linked with the appropriate functional area profiles, the Current Profiles tab will 

show the various profiles to which this account is linked. 

 
Check the permissions established by the Operator’s assigned profiles to determine that operator’s 

privileges in Voyager. Note: Any operator entered in SysAdmin may use the Voyager Slip Daemon or 
Voyager Reporter Client, even if they have no current Profiles Assigned.  

 

 
Security- Operator Profiles- Example operator, Current Profiles Tab 
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VI. Cataloging Profiles  
 

⊕⊕⊕⊕ Libraries should create as many Cataloging Profiles as needed to support local operations. 

 

 
Security- Cataloging Profile- Current Profiles Tab 

Overview  
The Cataloging Profiles determine the assigned operators’ permissions within the Cataloging Client. You 
should create cataloging profiles based on levels of permissions. Multiple operators can be assigned to 

the same Cataloging Profile. 
 

Information about Specific Cataloging Profiles in Voyager 

⊕⊕⊕⊕ When Ex Libris (ExL) creates a new Voyager database, Ex Libris staff may add a Cataloging Profile 

called “data review” for the data review process.  

• ⊕⊕⊕⊕ You should delete this Cataloging Profile once the library in live in production for Cataloging.  

∅∅∅∅ CARLI staff will create a Cataloging Profile in each I-Share library’s database to be used by CARLI staff 

only, for troubleshooting purposes.  

• ∅∅∅∅ Do NOT edit any settings in the Cataloging Profile with the name of “CARLI” (or “ILCSO” in 

older I-Share databases), including editing or adding/deleting any operators linked to these 

profiles.  
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Adding/Editing a Cataloging Profile 
In Voyager SysAdmin> Security> Cataloging Profiles 

• To Add a new Cataloging Profile, click [New]. 

• To Edit an existing Cataloging Profile, highlight the name and click [Edit]. 

• To Delete a Cataloging Profile, highlight the name and click [Delete]. 

 

When adding a new Cataloging Profile, complete all 5 tabs in the order described below, and then click 

[Save]. 

A. Profile Name Tab 

 
Security- Cataloging Profile- New Profile, Profile Name Tab 

 

⊕⊕⊕⊕ Give the new Profile a Name that is indicative of the authorization levels associated with it 

(examples include: Cat Supervisor, Cat Student, Cat View Only).  
• There is a 25 character limit to the profile name.  

• If the profile will be limited to specific locations within the library, name the profile to denote the 

location distinction. For example, if the library has both a Main and Law library, and the 

cataloging profiles include limitations based on locations, the library may wish to create both a 

Cat Main Supervisor and a Cat Law Supervisor profile. 
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B. Profiles Values Tab 

 
Security- Cataloging Profile- New Profile, Profile Values Tab 

 
Review pages 9-54 through 9-67 of the Voyager 9.1.1 System Administration User’s Guide 

for more information about Cataloging Profiles> Profile Values Tab. 
 

Click the corresponding check boxes as appropriate to activate the particular authorized activity for each 
type of record (bib, MFHD, item, authority). The View option is automatically grayed out (i.e., de-

activated) if the profile has Add, Delete, and/or Update checked/enabled. 

 
���� Cataloging profiles that are intended for staff that will copy (“Add”) bib records from the I-Share 

Universal Catalog should have the Export OK option enabled. 
• In the I-Share environment, Voyager’s Export capability is typically used in association with 

Bibliographic records, for “backloading” functionality.  
• When a bib record is marked as “OK to Export” in the Voyager cataloging client, that bib is later 

copied from the database and sent to OCLC to set the institution’s holding symbol in WorldCat. 
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C. Profiles Values Cont. Tab 

 
Security- Cataloging Profile- New Profile, Profile Values Cont. Tab 

 
Review pages 9-54 through 9-67 of the Voyager 9.1.1 System Administration User’s Guide 

for more information about Cataloging Profiles> Profile Values Cont. Tab. 
 

���� In Voyager Cataloging, there are MARC Tag Tables (per record type) that are used to validate the 

structure of the MARC record when it is added to or edited within the database.  

• For example, a bib record tag table would indicate that the 245 field (for main title) is mandatory 

in each record, and that it is not a repeatable field.  
• ���� CARLI recommends that only staff with high-level privileges have the option(s) to Add/Update 

any of the three record formats enabled. 
 

If your library only has one Voyager Owning Library established: 
• ���� recommended do not check “Allow Bibliographic Ownership Change” for appropriate profiles. 

• ���� recommended check “Attach Holdings to any Bibliographic Record” for appropriate profiles. 

 

If your library has more than one Voyager Owning Library established: 
• ���� recommended check “Allow Bibliographic Ownership Change” for appropriate profiles. 

• ���� recommended do not check “Attach Holdings to any Bibliographic Record”  for appropriate 

profiles. 
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���� CARLI recommends that the “Global Headings Change” option be disabled/unchecked. Most I-Share 

libraries do not use Global Headings Change. Contact CARLI Support to discuss recommended settings if 

your library does use Global Heading Change. 

D. Locations Tab 

 
Security- Cataloging Profile- New Profile, Locations Tab 

 

Review pages 9-9 through 9-11 of the Voyager 9.1.1 System Administration User’s Guide for 
more information about location limits. 

 

The values entered on this tab determine which holding and HAPPENING locations are valid for the 
profile.  

• The Available Locations box contains the locations that are not selected for this Cataloging 

Profile. Operators assigned to this Cataloging Profile are restricted from working with 
MFHDS/items in these locations. 

• The Selected Locations box contains locations that have been selected for this Cataloging Profile. 

Operators assigned to this Cataloging Profile are able to work with MFHDS/items in these 
locations. 

Use the arrow buttons to move the locations between the Available and Selected boxes.  

Individual locations can be selected for use in more than one Cataloging profile. 
 
���� Libraries that have no need to restrict cataloging activities based on holding locations should select all 

locations for that profile. 
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E. Operator Tab 

 
Security- Cataloging Profile- Example Profile, Operator Tab 

 
This is where individual Operators are linked to their appropriate Cataloging profile.  

Use the arrow buttons to move the operators between the Available and Selected boxes.  
 

An individual Operator can only be associated with one Cataloging profile.  

• In other words, the list of Available Operators includes accounts that have not been selected for 

any other Cataloging Profile.  
• If you do not see the operator you are looking for in the Available list, look at the operator’s 

current profile tab in their SysAdmin> Security> Operator Profile to see which profile they 

currently belong to. Deselect them from that profile, to make them available for the new profile. 
 

It is NOT necessary to assign every operator to a cataloging profile, depending on your library’s 
workflow.  

• For example, it is common for Circulation Student operators to not be linked to any cataloging 

profiles in SysAdmin Security, which means this operator will always remain in the Available 
Operators box. 

F. After all tabs have been populated for this profile, click Save. 
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VII. Circulation Profiles  
 

⊕⊕⊕⊕ Libraries should create as many Circulation Profiles as needed to support local operations. 

 

 
Security- Circulation Profile- Current Profiles Tab 

 

Overview  
The Circulation Profiles determine the assigned operators’ permissions within the Circulation Client. You 
should create circulation profiles based on levels of permissions. Multiple operators can be assigned to 

the same Circulation Profile. 

 
Information about Specific Cataloging Profiles in Voyager 
���� When Ex Libris (ExL) creates a new Voyager database, Ex Libris staff may add two Circulation Profiles 

called “Full Access” and “Restricted.” 
• ���� You can either edit these profiles to meet your library’s needs, or delete them and create new 

Circulation Profiles that better suit your library’s policies.  

∅∅∅∅ CARLI staff will create a Circulation Profile in each I-Share library’s database to be used by CARLI staff 

only, for troubleshooting purposes.  

• ∅∅∅∅ Do NOT edit any settings in the Circulation Profile with the name of “CARLI” (or “ILCSO” in 

older I-Share databases), including editing or adding/deleting any operators linked to these 

profiles.  
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Adding/Editing a Circulation Profile 
In Voyager SysAdmin> Security> Circulation Profiles 

• To Add a new Circulation Profile, click [New]. 

• To Edit an existing Circulation Profile, highlight the name and click [Edit]. 

• To Delete a Circulation Profile, highlight the name and click [Delete]. 

 

When adding a new Circulation Profile, complete all 8 tabs in the order described below, and then click 

[Save]. 

A. Profile Name Tab 

 
Security- Circulation Profile- New Profile, Profile Name Tab 

 

⊕⊕⊕⊕ Give the new Profile a Name that is indicative of the authorization levels associated with it 

(examples include: Circ Supervisor, Circ Student, Reserve Clerk).  

• There is a 25 character limit to the profile name.  

• If the profile will be limited to specific locations within the library, name the profile to denote the 

location distinction. For example, if the library has both a Main and Branch library, and the 
circulation profiles include limitations based on locations, the library may wish to create both a 

Circ Main Supervisor and a Circ Branch Supervisor profile. 
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B. Locations Tab 

 
Security- Circulation Profile- Locations Tab 

 

Review pages 9-9 through 9-11 of the Voyager 9.1.1 System Administration User’s Guide for 
more information about location limits. 

 

The values entered on this tab determine which circulation locations are valid for the profile.  
• The Available Locations box contains the locations that are not selected for this Circulation 

Profile. Operators assigned to this Circulation Profile are restricted from working with resources 

from these locations. 
• The Selected Locations box contains locations that have been selected for this Circulation Profile. 

Operators assigned to this Circulation Profile are able to work with resources from these 

locations. 

• The All Locations checkbox means that all existing locations, whether selected or not, are to be 

considered part of this profile. This includes any future locations that might be added. 
o Libraries that have no current or future need to restrict circulation activities based on 

holding or HAPPENING locations should check the All Locations checkbox for that profile. 
o If the All Locations box is checked, removing a location from the Selected Locations box 

will have no effect.  
Use the arrow buttons to move the locations between the Available and Selected boxes.  

Individual locations can be selected for use in more than one Circulation profile. 
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C. Profile 1 Tab 

 
Security- Circulation Profile- Profile 1 Tab 

 

Review pages 9-73 through 9-85 of the Voyager 9.1.1 System Administration User’s Guide 

for more information about Circulation Profiles> Profile 1 and Profile 2 Tabs. 
 

Click each check box as appropriate to enable that particular authorized activity.  

 

⊕⊕⊕⊕ All circulation profiles must have the Mask Patron Social Security Number option checked/enabled, for 
patron privacy purposes. There is a consortial policy prohibiting storing SSNs in patron records. Enabling 

masking of the SSN is an extra level of security to prevent unauthorized use of the SSN field in patron 
records. 

 

There are no other required default Circulation Operator settings, although it makes sense that each 
profile (other than View-only profiles) have the “Charge/Renew” option enabled.  
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D. Profile 2 Tab 

 
Security- Circulation Profile- Profile 2 Tab 

 
Review pages 9-73 through 9-85 of the Voyager 9.1.1 System Administration User’s Guide 

for more information about Circulation Profiles> Profile 1 and Profile 2 Tabs. 

 
Click each check box as appropriate to enable that particular authorized activity.  
 

⊕⊕⊕⊕ All circulation profiles must have the View Patron Info in Item Circulation History option 
unchecked/disabled, for patron privacy purposes. There is a consortial policy prohibiting the retention of 

the patron’s Circulation History. Disabling the ability to view the patron’s Circulation History is an extra 

level of security. 
 

There are no other required default Circulation Operator settings on the Profile 2 tab. 
 

If library staff will be able to use Pick and Scan in the Voyager Circulation client, it may make sense to 
check (enable) these settings: 

• Add/Update Item Records 

• Update Holdings Record With Pick And Scan 

• Delete Item Records 

• Delete Holdings Records 

• Delete Bibliographic Records 
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E. Item Blocks Tab 

 
Security- Circulation Profile- Item Blocks Tab 

 

Review pages 9-85 through 9-89 of the Voyager 9.1.1 System Administration User’s Guide 

for more information about Circulation Profiles> Item Blocks Tab. 
 

The Item Blocks tab specifies which item-related blocks an operator linked to the profile is able to 

override during a circulation transaction. 
 

Use the arrow buttons to move the item blocks between the Available Item Blocks and Operator May 
Override boxes. 
 
Individual item blocks can be enabled for override in more than one Circulation profile. 
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F. Patron Blocks Tab 

 
Security- Circulation Profile- Patron Blocks Tab 

 
Review pages 9-89 through 9-92 of the Voyager 9.1.1 System Administration User’s Guide 

for more information about Circulation Profiles> Patron Blocks Tab. 
 

The Patron Blocks tab specifies which patron-related blocks an operator linked to the profile is able to 
override during a circulation transaction. 

 

Use the arrow buttons to move the patron blocks between the Available Patron Blocks and Operator May 
Override boxes. 
 
Individual patron blocks can be enabled for override in more than one Circulation profile. 
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G. Patron Groups Tab 

 
Security- Circulation Profile- (Restricted) Patron Groups Tab 

 
Review pages 9-92 through 9-94 of the Voyager 9.1.1 System Administration User’s Guide 

for more information about Circulation Profiles> Patron Groups Tab. 
 

The Patron Groups tab allows you three options for restricting library staff interactions with Voyager 

Patron Records: Restrict Record Maintenance, Restrict Record View, and Restrict Circulation. 
 

Restrict Record Maintenance prevents the library staff members associated with the Circulation Security 
Profile from: 

• editing the patron records associated with the Restricted Patron Groups.  

• viewing the Outstanding Fines on an item, if the fines are associated with a patron from the 

Restricted Patron Group. 
 

⊕⊕⊕⊕ Do not check Restrict Circulation or Restrict Record View. These settings are problematic because they 

prevent library staff members associated with the Circulation Security Profile from being able to search 

for a patron record from the Restricted Patron Group. 
• Instead of receiving a warning that the patron record is restricted and cannot be viewed, library 

staff receive the error “Unable to find patron name” followed by “Unable to find patron.” 

• Example of problem: If you Restrict Record View for the “Problem Patron” patron group, and 

library staff search for a patron assigned to that patron group, they will not retrieve the patron’s 
record. They will not know the patron is already entered in the system, and may manually add a 

new record for the patron, thus allowing that Problem Patron borrowing privileges. 
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H. Operator Tab 

 
Security- Circulation Profile- Operator Tab 

 
This is where individual Operators are linked to their appropriate Circulation profile.  

Use the arrow buttons to move the operators between the Available and Selected boxes.  
 

An individual Operator can only be associated with one Circulation profile.  

• In other words, the list of Available Operators includes accounts that have not been selected for 

any other Circulation Profile.  
• If you do not see the operator you are looking for in the Available list, look at the operator’s 

current profile tab in their SysAdmin> Security> Operator Profile to see which profile they 

currently belong to. Deselect them from that profile, to make them available for the new profile. 
 

It is NOT necessary to assign every operator to a circulation profile, depending on your library’s 
workflow.  

• For example, it is common for Acquisitions Student operators to not be linked to any circulation 

profiles in SysAdmin Security, which means this operator will always remain in the “Available 

Operators” box. 

I. After all tabs have been populated for this profile, click Save. 
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VIII. Acquisition/Serials Profiles  
 

⊕⊕⊕⊕ Libraries should create as many Acquisition Profiles as needed to support local operations. 

 

 
Security- Acquisitions Profile- Current Profiles Tab 

Overview  
The Acquisitions Profiles determine the assigned operators’ permissions within the Acquisitions Client. 

You should create acquisitions profiles based on levels of permissions. Multiple operators can be assigned 

to the same Acquisitions Profile. 
 

Information for New I-Share Libraries 
• For a new I-Share library’s Voyager implementation, the library can begin to use 

Acquisitions/Serials as soon after the formal acceptance of the production bib load as desired.  

• However, many I-Share libraries wait to begin using Acq/Ser until after the beginning of a new 

fiscal period, which for many libraries is after they are live on Voyager for Circulation.  
• In addition, some I-Share libraries never choose to use Voyager Acq/Serials, as it is considered 

an optional Voyager component. 
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Information about Specific Acquisitions Profiles in Voyager 

∅∅∅∅ Because none of the new I-Share libraries in recent years have elected to convert any types of 

Acquisitions data to Voyager, there are no Acquisition/Serials profiles created by default by Ex Libris. 

∅∅∅∅ CARLI staff will create an Acquisitions Profile in each I-Share library’s database to be used by CARLI 

staff only, for troubleshooting purposes.  

• ∅∅∅∅ Do NOT edit any settings in the Acquisitions Profile with the name of “CARLI” (or “ILCSO” in 

older I-Share databases), including editing or deleting any operators linked to these profiles.  

Adding/Editing an Acquisitions Profile 
In Voyager SysAdmin> Security> Acquisitions Profiles 

• To Add a new Acquisitions Profile, click [New]. 

• To Edit an existing Acquisitions Profile, highlight the name and click [Edit]. 

• To Delete an Acquisitions Profile, highlight the name and click [Delete]. 

 

When adding a new Acquisitions Profile, complete all 5 tabs in the order described below, and then click 
[Save]. 

A. Profile Name Tab 

 
Security- Acquisitions Profile- New Profile, Profile Name Tab 
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⊕⊕⊕⊕ Give the new Profile a Name that is indicative of the authorization levels associated with it 

(examples include: Acq Supervisor, Acq Student, Serials Student).  

• There is a 25 character limit to the profile name.  

• If the profile will be limited to specific locations within the library, name the profile to denote the 

location distinction. For example, if the library has both a Main and Branch library, and the 
acquisitions profiles include limitations based on locations, the library may wish to create both a 

Acq Main Supervisor and a Acq Branch Supervisor profile. 

B. Profile Values Tab 

 
Security- Acquisitions Profile- New Profile, Profile Values Tab 

 

Review pages 9-40 through 9-48 of the Voyager 9.1.1 System Administration User’s Guide 
for more information about Acquisitions Profiles> Profile Values and Profile Values Cont. 

Tabs. 

 
Click each check box as appropriate to enable that particular authorized activity.  

 
When a new profile is being created, by default the View-Only options are always automatically grayed 

out (i.e., de-activated) if the profile has Add, Delete, and/or Update checked/enabled for each 

corresponding type of record. If Add, Delete, and/or Update is not checked/enabled for a record type, 
the View-Only option will remain greyed out, but will be considered activated. 
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C. Profile Values Cont. Tab 

 
Security- Acquisitions Profile- New Profile, Profile Values Cont. Tab 

 

Review pages 9-40 through 9-48 of the Voyager 9.1.1 System Administration User’s Guide 
for more information about Acquisitions Profiles> Profile Values and Profile Values Cont. 

Tabs. 
 

Click each check box as appropriate to enable that particular authorized activity.  
 

Note that the View-Only options are automatically grayed out (i.e., de-activated) if the profile has Add, 

Delete, and/or Update checked/enabled for each corresponding type of record. 
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D. Locations Tab 

 
Security- Acquisitions Profile- New Profile, Locations Tab 

 

Review pages 9-9 through 9-11 of the Voyager 9.1.1 System Administration User’s Guide for 
more information about location limits. 

 

The values entered on this tab determine which holding and HAPPENING locations are valid for the 
profile.  

• The Available Locations box contains the locations that are not selected for this Acquisitions 

Profile. Operators assigned to this Acquisitions Profile are restricted from processing materials in 
Acquisitions for that location. 

• The Selected Locations box contains locations that have been selected for this Acquisitions 

Profile. Operators assigned to this Acquisitions Profile are able to work with MFHDS/items in 
these locations. 

Use the arrow buttons to move the locations between the Available and Selected boxes.  

Individual locations can be selected for use in more than one Acquisitions profile. 
 
���� Libraries that have no need to restrict acquisitions activities based on holding locations should select 

all locations for that profile. 
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E. Operator Tab 

 
Security- Acquisitions Profile- Operator Tab 

 

This is where individual Operators are linked to their appropriate Acquisitions profile.  
Use the arrow buttons to move the operators between the Available and Selected boxes.  

 

An individual Operator can only be associated with one Acquisitions profile.  
• In other words, the list of Available Operators includes accounts that have not been selected for 

any other Acquisitions Profile.  

• If you do not see the operator you are looking for in the Available list, look at the operator’s 

current profile tab in their SysAdmin> Security> Operator Profile to see which profile they 
currently belong to. Deselect them from that profile, to make them available for the new profile. 

 

It is NOT necessary to assign every operator to an acquisitions profile, depending on your library’s 
workflow.  

• For example, it is common for Circulation Student operators to not be linked to any acquisitions 

profiles in SysAdmin Security, which means this operator will always remain in the “Available 
Operators” box. 

F. After all tabs have been populated for this profile, click Save. 
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IX. Master Profiles  
 

⊕⊕⊕⊕ Libraries should create ONLY as many Master Profiles as needed to support local 

operations. 
 

 
Security- Master Profile- Current Profiles Tab 

 

Review pages 9-23 through 9-38 of the Voyager 9.1.1 System Administration User’s Guide 
for more information about Master Profiles. 

Overview  
Master Profiles determine access privileges to the different areas within System Administration itself 
(e.g., the ability to add/edit Acq/Ser Profiles, Cat Profiles, Circ Profiles, Call Slip queues and rules, System 

Locations, Security settings, etc…). You should create master profiles based on levels of permissions. 
Multiple operators can be assigned to the same Master Profile. 

 

Information about Specific Master Profiles in Voyager 

∅∅∅∅ When a new Voyager database is created, a default Operator of “SYSADMIN” is created by ExL, and it 

is always associated with a Master Profile called “System Administrator.”  
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• This master profile is intended for use by ExL staff only, and its Operator and Profile values tabs 

cannot be edited.  

∅∅∅∅ CARLI staff will create a Master Profile in each I-Share library’s database to be used by CARLI staff 

only, for troubleshooting purposes.  

• ∅∅∅∅ Do NOT edit any settings in the Master Profile with the name of “CARLI” (or “ILCSO” in older 

I-Share databases), including editing or adding/deleting any operators linked to these profiles.  

Adding/Editing a Master Profile 
In Voyager SysAdmin> Security> Master Profiles 

• To Add a new Master Profile, click [New]. 

• To Edit an existing Master Profile, highlight the name and click [Edit]. 

• To Delete a Master Profile, highlight the name and click [Delete]. 

 
���� Library staff should create at least one new Master Profile that allows access to all parts of System 

Administration, and then link the appropriate library operator(s) to this high level master profile.  
• The library may also create additional master profiles as needed to allow access to specific parts 

of System Administration by library staff.  

• For example, the library might create a master profile called “Circulation SysAdmin” that would 

have Profile values enabled for “Circulation Policy Groups” (and perhaps other values), but not 

“Cataloging Policy Groups”. This would allow the operators associated with this profile to edit the 
library’s Circulation Policy Definitions in SysAdmin, but prevent these operators from accessing 

the Cataloging section of SysAdmin. 
 

When adding a new Master Profile, complete all 4 tabs in the order described below, and then click 

[Save]. 
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A. Profile Name Tab 

 
Security- Master Profile- New Profile, Profile Name Tab 

 

⊕⊕⊕⊕ Give the new Profile a Name that is indicative of the authorization levels and SysAdmin 

modules associated with it (examples include: AllSysAdmin, CircSysAdmin, CatSysAdmin).  
• There is a 25 character limit to the profile name.  

• If the profile will be limited to specific locations within the library, name the profile to denote the 

location distinction. For example, if the library has both a Main and Branch library, and the 

Master profiles include limitations based on locations, the library may wish to create both a 
MainCircSysAdmin and a BranchCircSysAdmin profile. 

• If the master profile is being created for an individual or staffing level, the name should be 

indicative of these titles (e.g., Library Director, Circ Supervisor). 
 
Click on the Profile Values tab next. We’ll come back to the Operator tab later. 
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B. Profile Values Tab 

 
Security- Master Profile- New Profile, Profile Values Tab 

 

Review pages 9-24 through 9-30 of the Voyager 9.1.1 System Administration User’s Guide 
for more information about Master Profiles> Profile Values Tab. 

 
When you create a new Master Profile, by default, all options are unchecked/disabled. Check the options 

that are applicable to the new master profile. Master profiles can be set up to include any combination of 

these options. 
 
���� CARLI recommends that a library have a minimum of two Operators with the Master Profile Value of 
Security (add, edit, delete) options enabled. However, enabling this value for more than two Operators 
should be carefully considered. 

• The Security (add, edit, delete) option is extremely powerful and should not be assigned to many 

people.  
• This authorization allows the operator to create, change, and delete individual Operator accounts 

in the database. It also has permission to change all Operators’ passwords. 
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If an Operator’s login is not associated with any Master Profile (i.e., their account is not authorized to 

have access to any parts of System Administration), if they attempt to log in to the SysAdmin client, their 
connection fails.  

• No error message is generated in this case; the SysAdmin client just closes automatically after 

the login and password are entered. 
 

If an Operator’s login is associated with a master profile that allows access to some, but not all, parts of 

System Administration, when they log in to the SysAdmin client, their resulting screen display will only 
include the parts of SysAdmin to which their master profile grants access.  

• For example: The “Media Supervisor” master profile in a generic Voyager training database has 

the following profile values selected: 
o Circulation Policy Groups 

o Cluster View-Only 
o Edit Patron Groups 

o Media Policy Groups 

 
When an operator linked to this “Media Supervisor” master profile logs into SysAdmin, she sees the 

following display in her SysAdmin client.  
 

 
System Administration options for an operator with limited Master Profile permissions. 

 

Note that this display contains many fewer options than the first screen shot in this document, which 
shows the display for an operator with access to all parts of SysAdmin. 
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C. Locations Tab 

 
Security- Master Profile- New Profile, Locations Tab 

 
Review pages 9-9 through 9-11 of the Voyager 9.1.1 System Administration User’s Guide for 

more information about location limits. 
 

Assigning Locations in the Master Profiles allows an individual location to be included in the list of 

Available Locations in the other parts of SysAdmin. 
• An example may be the best way to describe this functionality: 

o The library created a master profile named Circ-SysAdmin that on the Profile Values tab 
only has the Circulation Policy Groups (add/edit/delete) option checked/enabled.  

o On the Location Tab, the International Studies location, as pictured above, is not 

included in the Selected Locations box for this master profile. 

o Any operator linked to this profile, who is doing the Circ SysAdmin configuration, will not 
see the International Studies location listed in the Available Locations listing for the 
Circulation Policy Groups settings.  

• The Available Locations box contains the locations that are not selected for this Master Profile. 

Operators assigned to this Master Profile are restricted from seeing this location listed in other 

sections of Voyager SysAdmin. 
• The Selected Locations box contains locations that belong to the Master Profile currently being 

defined. Operators assigned to this Master Profile are will see these locations listed in other 

sections of Voyager SysAdmin. 
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Use the arrow buttons to move the locations between the Available and Selected boxes.  

Individual locations can be selected for use in more than one Acquisitions profile. 
 
���� Libraries that have no need to restrict access to the individual parts of SysAdmin by location should 

select all locations for that profile. 

D. Operator Tab 

 
Security- Master Profile- New Profile, Operator Tab 

 

This is where individual Operators are linked to their appropriate Master Profile.  
Use the arrow buttons to move the operators between the Available and Selected boxes.  

 
IMPORTANT NOTE: not all Operators in a database should be included in a Master Profile. Only those 

staff who should have access to SysAdmin should be associated with a Master profile.  

 
An individual Operator can only be associated with one Master Profile.  

• In other words, the list of Available Operators includes accounts that have not been selected for 

any other Master Profile.  
• If you do not see the operator you are looking for in the Available list, look at the operator’s 

current profile tab in their SysAdmin> Security> Operator Profile to see which profile they 

currently belong to. Deselect them from that profile, to make them available for the new profile. 

E. After all tabs have been populated for this profile, click Save. 
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X. Global Data Change Profiles 

 
Security- Global Data Change Profile- Current Profiles Tab 

 

CARLI does not currently support Voyager’s Global Data Change functionality. 
 

∅∅∅∅ CARLI recommends that you leave this section blank.  


